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Abstract 

 
Technical vocabulary which is largely used by people working or studying in a specialized 

field is a pivotal component in ESP classes. The main focus for vocabulary learning should not be 
about “How many words a student should know”, but “What words a student should know”. This 
paper presents a practical method for creating a technical vocabulary wordlist and Web-based 
materials for teaching and learning ESP. The files created use HTML and JavaScript, but readers do 
not need to know anything about these languages in order to use the programmes and the files.  

There are three computer programmes which are explained in this paper. All of them are 
explained in a practical and simple way that even a teacher with no computer knowledge 
background will be able to use them. The first programme, RANGE of Paul Nation, is used to create 
a technical vocabulary wordlist. The second one, HOT POTATOES from Half-Baked Software Inc., 
is used to create vocabulary quizzes. And, the third one, FrontPage of Microsoft Corporation, is for 
creating a Web-based technical dictionary. All of the Web-based materials created can be delivered 
and/or learned at any computer equipped with a browser, e.g. Internet Explorer. 
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I. Introduction 

One of the developments of applied linguistics that emerged in the recent years is the emphasis on 
language use in academic, disciplinary, and professional settings. This development has resulted in 
a need for subject-specific English. According to Jordan (1997:5), a subject-specific English 
includes the language structure, vocabulary, the particular skills needed for the subject, and the 
appropriate academic conventions. In this article, the writers explore further about the vocabulary 
because it has a significant role in language learning. Wilkins (1972: 111) argues that without 
grammar very little can be conveyed, while without vocabulary nothing can be conveyed. The 
importance of learning vocabulary is also supported by Rivers (1983:125) who mentions that the 
acquisition of an adequate vocabulary is essential for successful second language use because, 
without an extensive vocabulary, we will be unable to use the structures and functions we may have 
learned for comprehensible communication. 

According to Nation (2001:11-12), there are four kinds of vocabulary in a text: high frequency 
words, academic vocabulary, technical vocabulary, and low frequency words. High frequency words 
are the most frequent 2,000 words of English. West (1953) called these words a general service 
vocabulary because they were of use (or service) in most general texts. For learners with academic 
goals, the 570 word family Academic Word List of Coxhead (2000), the second kind of vocabulary, 
is like a specialised extension of the high frequency words. Academic vocabulary is common to a 
wide range of academic fields but it is not what is known as high frequency vocabulary and it is not 
technical in that it is not typically associated with just one field. Technical vocabulary, the third kind 
of vocabulary, is largely used by people working in a specialised field. The fourth kind of 
vocabulary consists of all the remaining words of English, the low frequency words.  

Chung and Nation (2003:114) mention that there is considerable research evidence about the 
nature and coverage of high frequency and academic words, but there has been little investigation of 
technical vocabulary. One of the reasons for this is that English teachers or linguists do not usually 
have specialist knowledge of the learners’ technical areas.  



Nevertheless, technical vocabulary which is largely used by people working or studying in a 
specialized field is a pivotal component in English for Specific Purposes (ESP) classes. There are 
three steps proposed here in providing vocabulary materials for teaching and learning ESP. The first 
step that teachers should do is to determine the technical vocabulary which pertain to the specific 
academic discipline. The second step is to create vocabulary quizzes which can be accessible by any 
Web browser for ease of learning. And, the third step is to create a Web-based dictionary to 
reinforce the mastery of the technical vocabulary. 

 
II. Discussion 
II. 1. Determining the Technical Vocabulary Using Range 

The first thing to do in determining the technical vocabulary is by choosing the passage related to 
the specific subject. The passage can be taken from a subject-specific textbook, a magazine, or a 
newspaper. It is more comfortable if the passage is taken from an online source. However, the 
passage must be copied, pasted, and saved in an MS-Word and .txt formats.  

The passage saved in the .txt format can then be run using Range1. This programme has several 
functions. One of them is to filter the non-technical words, using the three stop lists. The first word 
list includes the most frequent 1000 words of English. The second includes the second 1000 most 
frequent words, and the third includes words not in the first 2000 words of English but which are 
frequent in upper secondary school and university texts from a wide range of subjects. The first 
2000 words which are in the first and the second word lists, have been taken from A General 
Service List of English Words by Michael West (1953). The third word list, containing 570 word 
families, is taken from The Academic Word List by Coxhead (1998, 2000). 

After Range is installed in the computer, follow these steps to run Range: 
1. Double click on the RANGE icon in Windows explorer 
2. Open the File menu in RANGE and choose the heading Open. 
3. Select the file you want to run the program over.  
4. After you have selected the files, go to the File menu again and choose Save. Type the name 

of the file that you want to save the results to. 
5. Look at the list of options at the bottom of the RANGE window. You can change these 

options or leave the options as they are. 
6. Click the button Process Files which is below the file list in the RANGE window. 
7. Look at the results file using MS-Word. The result file is the name you chose plus _range.txt.  
In the result file, you can see a list of the words which are not in the stop lists. This can be 

considered the technical vocabulary. However, proper names, such as names of people, companies, 
etc., must be excluded. 
 

II. 2. Creating e-Vocabulary Quizzes Using Hot Potatoes 
After obtaining the list of technical vocabulary, e-vocabulary quizzes can be created using Hot 
Potatoes2. Actually, Hot Potatoes suite is a set of six authoring tools. For practical reason, only one 
authoring tool is described in this paper, i.e. JQuiz. The presentation, however, will include the 
Cloze test and Crosswords tools. JQuiz is a tool for making question-based exercises. Each quiz can 
consist of an unlimited number of questions. There are four basic question types, one of them is 
multiple-choice questions (MCQ). In the MCQ, the student chooses an answer by clicking on a 
button. If the answer is correct, the button caption will change to a smiley face :-), and if it is wrong, 
it will change to an X (these standards can be configured in the configuration screen). In either case, 
the student can see feedback specific to that answer, explaining why it is right or wrong, if you write 
the feedback when you make the exercise. 

In general, there are three main steps in creating an exercise: (1) entering data, (2) configuring 
the output, and (3) Creating Web pages. 

                                                      
1 RANGE can be downloaded from http://www.vuw.ac.nz/lals/staff/paul_nation/nation.aspx 
2 HOT POTATOES is created by the Research and Development team at the University of Victoria,  Humanities Computing 
and Media Centre (http://web.uvic.ca/hrd/hcmc/). 



 
II. 2. 1) Entering Data 

After Hot Potatoes is installed, it has to be registered at http://web.uvic.ca/hrd/hotpot/register.htm. It 
is necessary to register the programme so that there are more questions can be created. The user 
name and password will be sent by email. 

Once the user name and password are entered, the JQuiz programme can be started by clicking 
the icon, and an interface like the one below will appear. 
Look at the picture below, and type in the information: 

1. Type the title in the title box. 
2. Type the question in the question box. 
3. Make sure that "Multiple-choice" is selected in the drop-down list box to the right of the 

question. This defines the type of question you want to make. 
4. Type the answers in the boxes on the left, and the feedback on the right. Note that each 

answer, right or wrong, has its own feedback. 
5. Check the "Correct" checkbox next to answer B. 

 

 
 

 
II. 2. 2) Configuring the Output 

The configuration information is a collection of pieces of text, including instructions for doing the 
exercise, button captions, and link URLs, which are unlikely to change much from one exercise to 
another.  

From the above image, we can see that the exercise had a title, a subtitle, and some 
instructions at the top of the page. The title of each exercise is likely to be unique. However, the 
subtitle (e.g. "Multiple-choice exercise") and the instructions ("Choose the correct answer for each 
question") can be changed, if necessary. Another important configuration is the time limit for the 
exercise which can be tailored to every exercise. 



To change the configuration, first, click on Options / Configure Output to get to the 
configuration screen. The first tab, labelled Titles/Instructions, holds the exercise subtitle and 
instructions. Type some text in, as in the example below, then press OK. 

 

 
 

 Another important label id the Timer, in which you can configure the time allowed to do the 
exercise. The time duration is in minutes and/or seconds. 
 

II. 2. 3) Creating a Web Page 
The final step is to create a Web page from the data. This can be done by simply click on Create 
Web page / Web page for v6 browsers from the File menu, then give the page a filename. 

 



 

 
III. 3. Creating e-Dictionary Using the FrontPage Programme 

The list of technical vocabulary which is obtained from the first step, can further be used in making 
a simple e-dictionary. Actually, the best way to create an e-dictionary is by using MySQL and PHP. 
However, the programming is complicated and time-consuming. Therefore, they are not discussed 
in this paper. However, the discussion is focused on using FrontPage which is a lot easier and 
simpler. The main concept is the e-dictionary explained here uses a JavaScript to show the definition 
of each word. However, it is not a must for teachers to know the programming language of the 
JavaScript. 
The main steps to create the e-dictionary are as follows: 
1. Open the Microsoft FrontPage programme. You should choose the Normal view. 
2. Type the title of your page, e.g. e-Dictionary for Students of Economics at Airlangga University, 

then click enter. 
3. Click the Table menu, point to Insert, and then click Table. In the Rows box, type the number 

of rows you want, e.g. 2. In the Columns box, type the number of columns you want, e.g. 5. In 
the Alignment box, select the position for the table on the page, e.g. center. Finally, click OK.  

4. Click in the first cell, then switch to the HTML view, and you will see the following: 
<td width="20%">&nbsp;</td> 

5. After the semi-colon (;), type the following: 
<INPUT onclick="alert('……..')" type=button value=……  

6. The dots between the quotation marks represent the definition, while the dots after the equal 
sign (=) represent the technical word. Therefore, if you want to define the technical accounting 
word hedge as a contract entered into or asset held as a protection against possible financial 
loss, it should look like this: 
<INPUT onclick="alert(' a contract entered into or asset held as a protection against possible 
financial loss ')" type=button value=hedge  

7. Click the Normal view again to see the result. 
8. Click in the second cell, then switch to the HTML view. Now, you can type the definition and 

the technical word again, as in number 6, and so on. 
 

III. Conclusion 
Vocabulary learning is central to language acquisition. It is even becoming more important to 
comply with the needs of students studying a particular discipline. English teachers should give the 
students the words which are really important for their studies. Therefore, it is necessary for 
teachers of ESP to compile a word list which comprises the technical vocabulary. To keep abreast 
with the development of technology, it is also necessary for teachers to provide e-learning materials. 
However, as shown in this paper, e-learning materials can actually be created by anyone, even with 
a basic knowledge of computer language. 
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